Creating your ECE e-Portfolio on the OpenLab

How to Create your Early Childhood Education Major E-Portfolio on
the BMCC OpenLab

Please follow these steps to create your ECE e-Portfolio, using the designated ECE template
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Part | | Sign up (first time) or Log in to the BMCC Openlab

1) Navigate to the BMCC OpenLab https://openlab.bmcc.cuny.edu/, and follow these instructions:
https://openlab.bmcc.cuny.edu/blog/help/how-to-sign-up-and-log-in-to-bmcc-openlab-students-
staff-faculty/

Part Il | Create your portfolio with the designated ECE e-Portfolio Template

2) Navigate to My Profile. You can use several paths to get there:

1 - u o= e

e £ g
O‘ OPEN . \‘[ ) Members Courses Portfolios Communities Projects About Calendar Help|
¥ AT BMCC

My Settings " "
Jen Longley's Profile Faculty My Profile
My Courses
‘DACTIVE 10 SECONDS AGO e
My Communities My Portfolio Site ©
My Projects Portfolio Home
Title Faculty
My Friends
My Messages Pronouns she, her, hers
My Invitations Email jlongley@bmec.cuny.edu My Settings
Office Location S616C My Courses
Department Teacher Education My Communities
My Projects
Academic Program  Child Care/Early Childhood Education, A.5. HAEL
My Friends
My Messages
2 Edit Profile My Invitations
B Change Avatar Recent Activity
I,  leotlonglkycrestedshe


https://openlab.bmcc.cuny.edu/
https://openlab.bmcc.cuny.edu/blog/help/how-to-sign-up-and-log-in-to-bmcc-openlab-students-staff-faculty/
https://openlab.bmcc.cuny.edu/blog/help/how-to-sign-up-and-log-in-to-bmcc-openlab-students-staff-faculty/
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3) On your My Profile page, click on +Create Portfolio:

@
o < I - o X
¢ C @ openlabbmcc.cuny.edu/members/jlongley, * @O B % » Q
-\ 7 WIEIIDErS  LOUTSES  FOUTLIONUS  LOMIMUIUES  FIOJECS  Ldienudr  AUOUL  [eip %%
. Y AT BMCC
« My Profile ~ & ®H = Hi, Jen Longley = Log Out
|
tl -
Jen Longley’s Profile Faculty My Profile

DACTIVE 1 MINUTE

A Title Faculty My Profile
Pronouns she, her, hers My Settings
€ 2 - My Courses
Fl Email jlongley@bmcc.cumy.edu
\ My Communities
Office Location $-616C
My Projects
f Department Teacher Education
My Friends
g Academic P Child Care/Early Childhood Education, A.S.
i cademic Program ild Care/Early Childhood Education, My Messages ®
My Invitations

L4 # Edit Profile
Apr

@ Change Avatar

Recent Activity

Jen Longley added the

( event Module 7 Due
f] 1 DAY, 17 HOURS AGO
o Courses © Communities © Projects ©
m; ECE 110 Seminar | ECE Shared Cloning Teach On!
b Section 092 | Ea est Te o — - Jen Longley joined the -
-l © Type here to search (0] =i} » Q [ ] = B *» Ll P Ml v A @ m 0) B

4) You will see Create Portfolio | Step One: Portfolio Creation. Scroll down to Name
(required); you will see a box auto-populated with Firstname Lastname’s Portfolio. Click on the
text box, after your last name and before Portfolio type “ECE”, so the name reads “Your
Firstname Lastname’s ECE Portfolio”:

@& openlab.bmcc.cuny.edu/groups/create/step/group-details/?group_type=portfolio8&new=true

+~ OPENLAB
QAT BMCC

My Profile ~ Hi, Jen Longley Log Out

Members Courses Portfolios Communities Projects Calendar About

Create Portfolio My Profile

Step One: Portfolio Creation My Profile

My Settings
Set up the name, URL, avatar, and ather settings and permissions for your partfolio. These settings affect the portfolio home,
discussion, docs, and files My Courses.

My Communities

Name (required) My Projects

My Friends
The suggested Portfolio Name below uses your first and last name. If you do not wish to use your full name, you may change
My Messages
it now or at any time in the future.
. My Invitations
+ FirstName LastName's Portfolio

+ Jane Smith's Portfolio (Example)

Recent Activity
Jen Longley's Portfolio
Jen Longley added the
. event Module 7 Due

2 1 DAY. 17 HOURS AGO

URL (required)

Choose a unique URL that will be the home for your portfalio. Jen Longley joined the
group Test Faculty's Port-

hitne:iananlzh ke come sy

L Type here to search
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5) Go to the URL (required) box and click your cursor in the box. The box should auto-populate
with the URL for your e-Portfolio. If you see a red X at the end, add any two numbers after the
word “portfolio.” If the URL does not automatically populate, type your-name-ece-eportfolio, in
lower case letters, with a dash between each word. Be careful! This URL cannot be changed:

 BMCC OpenLab
<« &) @ openlab.bmcc.cuny.edu/groups/create/step/group-details/?group_type=portfolio&new=true

Step One: Portfolio Creation My Profile

) My Settings
Set up the name, URL, avatar, and other settings and permissions for your portfolio. These settings affect the portfolio home,
discussion, docs, and files My Courses

My Communities

Name (required) My Projects
My Friends

The suggested Portfolio Name below uses your first and last name. If you do not wish to use your full name, you may change My M

it now or at any time in the future. ly Messages
itation:

+ FirstName LastName's Portfolio My Invitations

+ Jane Smith's Portfolio (Example)

Recent Activity

Jen Longley's ECE Portfolio
Jen Longley added the

g event Module 7 Due

D1 DAY. 17 HOURS AGO

URL (required)

Choose a unique URL that will be the home for your portfolig Jen Longley joined the
group Test Faculty's Port-
https://openlab.bmec.cuny.edu/groug folio

"D 4DAYS, 20 HOURS AGD

Upload Avatar Jen Longley added the

lg} event Module 6 Due

Upload an image to use as an avatar for this portfolio. The image will be shown on "D 5 DAYS, 23 HOURS AGO

the portfolio home page, and in search results.

£ Type here to search

6) Optional: Scroll down to Avatar, and upload an image if you would like.
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7) Scroll to Description > type “Your Firstname Lastname’s ECE e-Portfolio”:

§ BMCC OpenLab

<« (¢ @ openlab.bmcc.cuny.edu/groups/create/step/group-details/?group_type=portfolio8inew=true
Jen Longley added the
event Module 6 Due
s

Upload Avatar
"D 5 DAYS, 23 HOURS AGO

Upload an image to use as an avatar for this portfolio. The image will be shown on

the portfolio home page, and in search results.

The maximum upload size is 150 MB.
Jen Longley added the

Upload g event Module 5 Due
\ J "D 5 DAYS, 23 HOURS AGO

Drop your file here
or

Select your File

Can't decide? You can upload a photo once the portfolio is created.

Description (required)

< Jen Longley ECE e-Portfolio >

Academic Units

P Type here to search

Scroll down to Academic Units. Under Departments, scroll to and select Teacher Education.
After you click Teacher Education, the Academic Programs section will populate. Select Child

Care/ Early Childhood Education, A.S.:

8)

{F BMCC Openlab
@ openlab.bmcc.cuny.edu/groups/create/step/group-details/?group_type=portfolio&new=true

<« c

Academic Units

Departments

| Speech. Communications, and Theatre Arts
B Teacher Education

] Other

Academic Programs

CJ Bilin .
Child Care/Early Childhood Education, A.S.
giee.a e

Offices and Centers

L] Asap
) BMCC Learning Academy

[ career Development

Porfolio Contact

R Type here to search
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9) Scroll to Privacy Settings and select Private:

BMCC OpenLab

C @ openlabbmcc.cuny.edu/groups/create/step/group-details/?group_type=portfolio&new=true

Privacy Settings

These settings affect how others view your portfolio. You may change these settings later in the portfolio settings.
Public

« Portfolio and related content and activity will be visible to the public.
 Portfolio will be listed in the "Portfolios" directory, in search results, and may be displayed on the OpenLab home

fgglab member may join this portfolio.

rivate

ollo content and activity will only be visible to members of the portfolio.
 Portfolio will be listed in the "Portfolios" directory, in search results, and may be displayed on the OpenLab home
page.
* Only OpenLab members who request membership and are accepted may join this portfolio.
) Hidden

« Portfolio content and activity will only be visible to members of the portfolio.
« Portfolio will NOT be listed in the "Portfolios" directory, in search results, or on the OpenLab home page.
* Only OpenLab members who are invited may join this portfolio.

Create and Continue ©

YOLI ARF HFRF HOMEF / GRg
(-l O Type here to search

10) Click Create and Continue.

11) On the Create Portfolio | Step Two: Associated Site Creation page, scroll down to

Associated Site Template:

i <« CcC o @ openlab.bmce.cuny.edu/groups/jen-longleys-ece-portfolio-531996924/admin/site-details/
' Portfolio: Jen Longley’s ECE Portfolio Admin
} Settings: Portfolio Details | Site | Settings | @ Delete Portiolio

Associated Site Details

Take a moment to consider an address for the site associated with your portfolio. You will not be able to change it once
you've created it.

® Create a new site:

openlab.bmec.cuny.edu/ | jen-longley-portfolio-6

O Use an existing site:

© Use an external site:

Associated Site Template

Filter by Category:

All Categaries v

S

ECE 710 Course
Description & Academic
Artifact

Portfolio Profile
Membership (1]

Settings.
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12) Click on Early Childhood Ed (ECE) Major Portfolio Template so the edges turn blue:

| < cC O & openlab.bmcc.cuny.edu/groups/jen-longleys-ece-portfolio-531996924/admin/site-details/

Associated Site Template

Filter by Category:

All Categories v
m; g -
ECE 210 Course
Description & Academic

Artifact

Portfolios
Early Childhood Ed (ECE) Major
Portfolio Template

Associated Site Privacy Settings

These settings affect how others view your associated site.

Public
@® Allow search engines to index this site. The site will show up in web search results.

© Ask search engines not to index this site. The site should not show up in web search results.

Note: This option will NOT block access to the site. It is up to search engines to honor your request.

Private

8 O Typehere o search o 85 @ ©o R @ A 0 -~ 3 $& @ - * B HE 0 TE -
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13) Scroll down to Associated Privacy Settings and select Private | | would like this site to

visible only to members of this community:

§ BMCC Openlab

< C & openlab.bmcc.cuny.edu/groups/create/step/site-details/
Associated Site Privacy Settings

These settings affect how others view your associated site.

Public

) Allow search engines to index this site. The site will show up in web search results.

© Ask search engines not to index this site. The site should not show up in web search results.

) I would like the site to be visible to community members with a role on the associated site.

Private

@ | would like the site to be visible only to of this

Hidden

© 1 would like my site to be visible only to those members with an administrator role on the associated site.

Member Role Settings

These settings control the default member roles on your associated site when members join the group. You may also adjust
individual member roles in Membership settings and on the site Dashboard.

Group members have the following role on the associated site:

¢ BMCC Openlab

<« &

@ openlab.bmec.cuny.edu/groups/create/step/site-details/
Member Role Settings

These settings control the default member roles on your associated site when members join the group. You may also adjust
individual member roles in Membership settings and on the site Dashboard.
Group members have the following role on the associated site:

Author

Group moderators have the following role on the associated site:

Editor

Group ad rators have the foll; role on the associated site:

Administrator

[ Member Role Definitions: Portfolio

[ Member Role Definitions: Associated Site

@ Previous Step Next Step @

YOU ARE HERE HOME / GROUPS

2. OPENLAB
AT BMCC

R Type here to search

Members Courses Portfolios Communities Projects Calendar About

Help

the group ECE 209-091W
Lectus nfant Care &
Curriculum - Fall 2020 - J.
Longley

D1 WEEK AGO

Jen Longley wrote a new
blog post Module 8 Physi-
cal Develo) ign-
ment #1: Infant Physical
Development in the group
ECE 209-091W Lecture - In-
fant Care & Curriculum -
Eall 2020 - J. Longley:

D1 WEEK AGO

Jen Longley created the
group ECE Shared Cloning
Test Template

‘D 1 WEEK, 5 DAYS AGO

My Profile

be



Creating your ECE e-Portfolio on the OpenLab

15) Click Finish:

- BMCC Openlab

<« c @& openlab.bmce.cuny.edu/groups/create/step/invite-anyone/

>~ OPENLAB
QAT BMCC

My Profile + HiJenlongley  LogOut

Members Courses Portfolios Communities Projects Calendar About Help

Create Portfolio My Profile

Step Three: Invite Members to Portfoli
ep Three: Invite Members to Portfolio My Portfolio Site ©

Portfolio Home | Dashboard
Invite OpenLab Members to Portfolio

My Profile
Search for OpenLab Members to invite to your portfolio: Y

My Settings

My Courses
Start typing o few letters of member's display name. When a dropdown list appears, select from the list. My Communities
These members will be sent an invitation. Click ‘Finish’ to continue. My Projects
My Friends

My Messages

@ Previous Step | My Invitations

Recent Activity

Jen Langley joined the
group Test Faculty's Port-
folio

£ Type here to search

Part Il | Set up and Personalize your ECE e-Portfolio

16) From your ECE Portfolio Profile, click Visit Portfolio Site:

BMCC Opentab
C @ openlab.bmcc.cuny.edu/groups/jen-longleys-ece-portfolio71/

>A~.OPENLAB
Q" ATBMCC

My Profile & Hi, Jen Longley = Log Out

Members Courses Portfolios Communities Projects Calendar Help

Portfolio: Jen Longley’s ECE Portfolio

Visit Portfolio Site ©

This Portfolio is PRIVATE, but all logged-in OpenL.ab members may view the corresponding Site.

Department Teacher Education Portfolio Profile

Academic Program  Child Care/Early Childhood Education, A.S. Membership

" Settings
Porfolio Contact Jen Longley.

Description Jen Longley ECE e-Portfolio

Member Profile Jen Longley

Recent Posts © Recent Comments ©

ECE 210 Course Description & Academic Artifact No Comments Found

Social Foundations of Early Care and Education Course Description
This course [...]See More

£ Type here to search
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17) On your ECE e-Portfolio About Me site page, scroll down to Edit:

= Academic artifacts from my ECE courses
= Documentation of my supervised fieldwork experiences

= My resume

The video below (https:/youtu.be/3xtRXSIYGvY) provides instructions on using
your e-Portfolio — please delete when finished your last 400-level ECE course

(@ Personalizing ECE ePortfolio

ECE110-S Course
Descriptio: demic
Artifact

~bosnws

O Type here to search O Hi e @ Q 6 ' " ﬂ @ O o o T9°F Sunny A G & wm D) ::,‘Dx| B

18) A text box will appear, allowing you to edit the text on the page. Replace the dashes in the first
line with your name:

<« CcC O & operiab bmcccuny edufon-longhey portiolo- 7Awp-admin/post phoTpost = 1 S Saction=edt
B "outte ‘ ot Q Mage By Traceiete o Lavelry Drperotosts WD Yevecs Qending - £

N Sere’ Stokied 10 e yOu're i) Sengle Custom Pt Ondier fon 4 few days now - RO you Mg i1 J

m el e lmer  Ronlibhom soee

About Me

Permalind: Intgs/Secribbaciooedaicniongier porsiolo: 1)

L.
| Gy Add Mada

twagmh v B I £ E € =
-—-A-@BOoOQRW®DHC

# =8

| .lm- and | am a student in the Earty Childhood Education [ECE) program in the
Teacher Education Department M Borough of Manhattan Comenunity CoBege (BMCC), In
the ECE program, my specialization & (infants and toddlers/ preschook age children). This
e Poctfolio showcases my work and experences while at BMCC. This ¢-portiolio contains
the following mdormatsoey:

® Academic artiacts from my ECE courses

9
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19) On the third line, identify your specialization—infants and toddlers or preschool-age children.
Delete the text that is NOT your specialization, including the parentheses and slash (/). Keep
the text that is your specialization:

Hi there! Stoked to see you're using Simple Custom Post Order for a few days now - hope you like it! And if you do, ple

GEICRUINIIGIONN  Remind me later Don't show again

Add New About Me

® Comments Permalink: https://openlab.bmcc.cuny.edu/ien-longley-portfolio-7/

o

* Plugins Paragraph v B I = i ¢ =

i
hh
%
El
[]

& Tools

J

c*
C

. lam Jen Longley and | am a student in the Early Childhood Education (ECE) program in
B Settings the Teacher Education Department at Borough of Manhattan Community College (BMCC).

© Collapse menu In the ECE program, my specialization is {(IUERISENTeRGTs (| TRTR ) ool TR G IR

This e-Portfolio showcases my work and experiences while at BMCC. This e-portfolio
contains the following information:

= Academic artifacts from my ECE courses

= Documentation of my supervised fieldwork experiences

20) After you have finished editing, click Update on the right:

0] Media Hi there! Stoked to see you're using Simple Custom Post Order for a few days now - hope you like it! And if you do, please consider rating it. It would mean the world to us. Keep on rocking! [x]
g
@ Pages GEIGRGERG G Remind me later Don't show again
All Pages
Add New [ About Me l Page Attributes ANV s
P Comments Permalink: https://openlab.bmcc.cuny.edu/jen-longley-portfolio-7/ Parent
(no parent) v
# Appearance 0 add vedia o |
3 i _ _ Order
L7 bzl Paragraph v B I = E & E = £ £ =
1
.
aa Users m_ivﬁogg_§=§§cg
# Tools Need help? Use the Help tab above the
I'am Jen Longley and | am a student in the Early Childhood Education (ECE) program in screen title.
1t i . .
B Settings the Teacher Education Department at Borough of Manhattan Community College (BMCC).
© collapse menu In the ECE program, my specialization is infants and toddlers. This e-Portfolio showcases publish v s

my work and experiences while at BMCC. This e-portfolio contains the following

information: Preview Changes

= Academic artifacts from my ECE courses 9 Status: Published Edit

@ Visibility: Public Edit

= Documentation of my supervised fieldwork experiences
€D Revisions: 4 Browse

= My resume [ Published on: Sep 3, 2028

Move to Trash
The video below (https://youtu.be/sD5g-11dddQ) provides instructions on using

your e-Portfolio -- please delete when finished your last 400-level ECE course

Custom Fields AV 4

P Name Value
Word count: 87 Draft saved at 2:42:56 pm. Last edited by Jen Longley on September 27, 2021 at 6:48 pm \r \ -

10
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21) Find the black horizontal bar at the top of the page, hover over the title of your site,
Yourname’s ECE e-Portfolio (yellow rectangle below), so that Visit Site appears (purple
rectangle below). This will take you to the home page (About Me) of your ECE e-Portfolio site:

Cc O @& openlab.bmec.cuny.edu/jen-longley-portfolio-7/wp-admin/post.php?post=3418action=edit

Apps G Gmail @ YouTube g, Posts @ Maps B Transiate (@) Ravelry: Drjennknits.. [ Needs Grading - C...

A OPENLAB
QAT BMCC R

@ Dashboard Edit Page

f Posts
0] Media Hi there! Stoked to see you're using Simple Custom Post Order for a few days now - hope you like it! And if you do, please consider rating it. It would mean
@ Pages GEIGRUERITGIGE  Remind me later  Don't show again
All Pages i .
Add New ‘ About Me ‘ Pa
| Comments Permalink: https://openlab.bmcc.cuny.edu/jen-longley-portfolio-7/ Pa
- (
# Appearance 9 Add Media Visual | Text ‘*
. or
K Plugins baragraph v B I = E & = = g
)
s “ - AvEB O Q== -
& Tools Ne
: lam - and lam a student in the Early Childhood Education (ECE) program in the sel
B Settings Teacher Education Department at Borough of Manhattan Community College (BMCC). In
© Collapse menu the ECE program, my specialization in (infants and toddlers/ preschool-age children). This P
e-Portfolio showcases my work and experiences while at BMCC. This e-portfolio contains
the following information:
= Academic artifacts from my ECE courses ?
€
= Documentation of my supervised fieldwork experiences ~
(O]

fien-longley-portfolio-7/ Last edited by Jen Longley on September 28, 2021 at 2:44 pm

11
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Part IV | Upload your Materials to Your ECE e-Portfolio

22) In your site menu, click on Academic Artifacts (yellow circle below) > your specialization—
Infant-Toddler Specialization or Preschool Specialization—(turquoise square below) > click on
the class to which you would like to upload materials (purple arrow below):

nlab.bmec.cuny.edufjen-lc

- . 1 -
ARequired Poriglioger Early Childheed Education majors Gt.thé Berough of Mamhattan G@mmunity€ollege-
¥ é b F LD~ ¢ /i

) 4

[ Portfolio Profile ]

Infant-Toddler ECE 110 Cou
Specialization Description
Artifact
Preschool Specializatio
ECE 110-Seminar Course
Description & Academic
Artifact
lam ——- and | am a student in { (ECE) program in the
Teacher Education Department CE209C lunity College (BMCC). In
the ECE program, my specializati

school age childrenj This
e-Portfolio showcases my work ) This e-portfolio

the following information:

Artifact
= Academic artifacts from m
ECE 210 Col

Descript

= Documentation of my sup s

= My resume

The video below (https://yout s instructions on using
your e-Portfolio — please del SIS ST -  400-level ECE course
Description & Academic
Artifact

ECE 409 Course

Description & Academic
Artifact

E410 Cot
Description &
Artifact

o @ - EQE~Te®OMH PN

23) Click Edit:

< C O @ openlabbmcccuny.edu/jen-longley-portfolio-7/2020/08/08/ece-209-seminar-course-description-academic-artifact e
# Apps G Gmail @B YouTube g Posts @ Maps By Transiste Needs Grading - C Reading ki
[ Portfolio Profile ] About Me Academic Artifacts Fieldwork Resume Links Q

ECE 209-Seminar Course
Description & Academic
Artifac

ECE 209- Seminar
Course Description:

This course focuses on the theories, methods and materials of early childhood education
for infants (birth to eighteen months), with an emphasis on addressing developmental
needs and culturally appropriate practices in their education and care. The following top:
ics are explored in depth: social, emotional, cognitive and physical development of infants;
basic principles of infant care giving, including providing culturally sensitive and consistent

care; an of the and d ally appropriate experiences to
promote infant growth and learning; the role of parents and establishing partnerships with
families.

Artifact: Teaching Belief Statement

& Tara Seeley.png ~ Showall X

p— oHn @ - ®EC -~ 3 e ® 0@ €C (2 A Goma puT B
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24) The text box will appear. Put your cursor under Artifact: Name of Artifact > press the
Enter/Return key so the cursor is flashing. This tells the program where you want the
document to appear:

< C' (0 @ openlab.bmcc.cuny.edu/jen-longley-portfolio-7/wp-admin/post.php?post=176&action=edit T * e H

Apps G Gmail @ YouTube g Posts @ Maps B Translate Q) Ravelry: Drjennknits.. [@ Needs Grading - C.. Reading list
B Media

. Permalink: hitps.//openlab.bmec.cuny.edu/jen-longley- portfolio-7/2020/08/08/ece-209-seminar-...cademic-artifac P —
Pages

9 Status: Published Edit

’ Comments .
Visual = Text

@ Visibility: Public Edit

# Appearance Poragraph v B I B Published on: Aug 8, 2020 at 17:55 Edit
& Plugins we — A vl QO
. Move to Trash
aa Users
F Tooks ECE 209- Seminar
Format AV 4
SEilnge Course Description:
o Collapse menu e * standard
This course focuses on the theories, methods and materials of early childhood education O Aside
forinfants (hirth to eighteen months), with an emphasis on addressing developmental O Audio
needs and culturally appropriate practices in their education and care. The following O Chat
topics are explored in depth: social, emotional, cognitive and physical development of -
infants; basic principles of infant care giving, including providing culturally sensitive and '\:) Gallery
consistent care; arrangement of the environment and developmentally appropriate O Image
experiences to promote infant growth and learning; the role of parents and establishing @] Link
partnerships with families, O Quote
O Status
Artifact: Teaching Belief Statement O [ video
l Tags NV

P

Word count: 94 Last edited by Jen Longley on September 27, 2021 at 6:22 pm [:]

Separate tags with commas

Excerpt AV v

Choose from the most used tags

25) Click Add Media:

(r @ openlab.bmcec.cuny.edu/jen-longley-portfolio-7/wp-admin/post.php?post=176&action=edit

mail @ YouTube g, Posts @ Maps B Transiate @) Ravelry: Driennknits.. [ Needs Grading - C..

Permalink: https://openlab.bmcc.cuny.edufjen-longley-portfolio-7/2020/08/03/ece-209-seminar-...cademic-artifact/

Visual  Text
I = £ ¢
o 0=

g
n

ECE 209- Seminar
Course Description:

This course focuses on the theories, methods and materials of early childhood education
for infants (birth to eighteen months), with an emphasis on addressing developmental
needs and culturally appropriate practices in their education and care. The following
topics are explored in depth: social, emotional, cognitive and physical development of
infants; basic principles of infant care giving, including providing culturally sensitive and
consistent care; arrangement of the environment and developmentally appropriate
experiences to promote infant growth and learning; the role of parents and establishing
partnerships with families.

Artifart. Taarhino Raliaf Qtatamaent

13




Creating your ECE e-Portfolio on the OpenLab

26) Click Upload Files > Select Files (PDFs only). (To convert a Word document to a PDF, open
the Word document, go to File > Export > Create PDF. To convert a Google document to a
PDF, open the Google doc > File > Download > PDF. To convert a Pages document to a PDF,
open the Pages doc > Export To > PDF.)

< cC o0 & openlab.bmcc.cuny.edu/jen-longley-portfolio-7/wp-admin/post.php?post=176&ac

tion=edit * * O

i Apps G Gmail @B YouTube gf Posts @ Maps By Translate @@ Ravelry: Drjennknits.. [ Needs Grading - C [E] Reading list

Actions

Add media Upload files | Megia

Create gallery
Create audio playlist
Create video playlist

Featured image

Insert from URL

Drop files to upload

or
Select Files

Maximum upload file size: 150 MB.

27) Drag or select the file you would like to upload. If you select the file, click Open at the bottom-
right corner of the screen:
1 @

Caring Community

Cognitive

&) HCDC_ServeRetum_for_Parents_Caregiver.
£ Responsive caregiving scenarios
& South-Carolinas-Infant-Toddler-Field-Gui

B3 Temperament & Teaching Infants Hando.

©= What is Attachment

<

File name: | Responsive caregiving scenarios

Open Chcel

14



Creating your ECE e-Portfolio on the OpenLab

28) Check that the correct document is ready to insert—that s, it is outlined in blue box with a check-
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ECE 209- Seminar

Course Description:

This course focuses on the theories, methods and materials of early childhood education
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needs and culturally appropriate practices in their education and care. The following
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